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Introduction 
 
The present user manual is designed for the Landis+Gyr MAP120 Para-
meter Editor Version 6.2 and higher.  
 
This user manual contains all information required for the use of the 
Landis+Gyr MAP120 Parameter Editor. It not only provides explanations 
concerning functionality and general procedures, but also gives detailed, 
illustrated instructions on how to use the software. 
 
The contents of this user manual are intended for technically qualified per-
sonnel of energy supply companies responsible for system planning, para-
meter setting and installation of devices. 
 
The Landis+Gyr MAP120 Parameter Editor runs on personal computers 
with the Windows operating system. To understand this user manual, you 
need basic knowledge of Windows and its terms, as well as a general idea 
of how to operate a personal computer. Furthermore, you need to be famil-
iar with the functional principles of the various devices supported by the 
Landis+Gyr MAP120 Parameter Editor, which are described in the corre-
sponding user manuals and functional specifications. 
 
The following conventions are used in this manual: 

1. 2. 3.  Ordinal numbers are used for individual steps in the instruc-
tions.  

View Buttons, menu names and individual menu items appear in 
bold text. 

[F1] Keys are shown in square brackets. 

[Ctrl]+[S] Key combinations are shown with a plus sign (e.g. [Ctrl] key 
kept pressed while pressing [S] key) 

"Open" Names of windows, directories and elements appear in quota-
tion marks.  

 

Scope 

Purpose 

Target group 

Conditions 

Conventions 
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1 Overview 
The Landis+Gyr MAP120 Parameter Editor supports services needed to 
edit and download complete device definitions (parameterisations) into 
Landis+Gyr devices (meters, communication modules and communication 
units).  

The following diagram illustrates the various fields of application of the 
Landis+Gyr MAP Tools. 

 

1.1 Functions 

The Landis+Gyr MAP120 Parameter Editor supports the following func-
tions:  

¶ Create and edit device definitions 

¶ Read complete device definition from a device 

¶ Wizard to write complete device definition to a device and execute 
related actions (e.g. clock setting, register reset) 

¶ Write data blocks to a device (e.g. TOU, security system) 

¶ Save and open complete device definition files 

¶ Compare two device definitions 

¶ Print a device definition 
 

1.2 Communication channels 

The Landis+Gyr MAP120 Parameter Editor can communicate with the 
devices via the following communication channels: 

¶ Local: Optical head, RS232, RS4585, CS, M-Bus  

¶ Modem: PSTN, GSM  

¶ Network: GPRS, Ethernet  
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1.3 Communication protocols 

The Landis+Gyr MAP120 Parameter Editor supports the following com-
munication protocols:  

¶ dlms / HDLC 

¶ dlms / COSEM Wrapper over TCP 

¶ IEC 62056-21 (formerly known as IEC 1107) 
 

1.4 Editions 

The Landis+Gyr MAP120 Parameter Editor is solely as "Professional 
Edition" available. 

The edition is determined by the licence data (see section 3 "Licensing").  
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2 Installation and uninstallation 
This section describes the installation of the Landis+Gyr MAP120 Para-
meter Editor on the hard disk of your PC and its uninstallation if it is no 
longer used.  

2.1 Installation 

 
To be able to run the Landis+Gyr MAP120 Parameter Editor, your PC must 
be equipped with the operating system Windows 10, Windows 8, Windows 
7 or Windows Vista.  
 
Administrator privileges on your computer are required for the installation 
and the licensing.  
 
The installation software for the Landis+Gyr MAP120 Parameter Editor can 
be downloaded to your PC via the Internet from the Landis+Gyr homepage 
www.landisgyr.eu. Please contact your sales representative to receive the 
required username and password for the download. 
 
The required language must be selected at installation time. It can be 
changed again at any time in the Landis+Gyr MAP120 Parameter Editor. 
 
Please read the file "MAP120_ReadMe.txt" with current information about 
the present version of the Landis+Gyr MAP120 Parameter Editor. 
 
Start the installation file "Setup.exe" and then follow the instructions of the 
setup wizard. 
 
Close the Landis+Gyr MAP120 Parameter Editor, if it is in use. Then Start 
the installation file "Setup.exe" and follow the instructions of the setup wiz-
ard. 

All data including the license and the communication profiles is kept when 
upgrading the Landis+Gyr MAP120 Parameter Editor with version 2.3 or 
later (older versions than 2.3 cannot be upgraded). 

When upgrading a former version 6.2 to the latest version 6.2 the former 
version will be automatically replaced by the newer one.  

When upgrading a former version 2.3, 2.4, 2.5, 3.x, 4.x, 5.0 to 5.4, 5.7 or 
5.8 to the latest version 6.2, the new version can also be installed in parallel 
to a former version. In this case a separate directory is required for the in-
stallation.  

Former releases prior to 2.3 can't be upgraded.  

To restore the communication profiles of versions older than 4.0 copy the 
content of the "\profiles" subdirectory from the former to the new version. 
Since version 4.0 the communication profiles are located in the following 
directory: 

¶ Users\%username%\AppData\Roaming\Landis+Gyr\MAP120. 
 
With the configuration settings you can also define any other directory for 
the communication profiles to allow the sharing of communication profiles 
with different users of a PC.  
 

System requirements 

Administrator 
privileges 

Installation software 

Language 

Preparation 

First installation 

Upgrades 

http://www.landisgyr.eu/product/map/
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2.2 Uninstallation 

If the Landis+Gyr MAP120 Parameter Editor is no longer needed, it should 
be uninstalled.  

To do so, open the Windows Control Panel and use "Uninstall a program" 
from the "Programs" category. 
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3 Licensing 
This section explains the licensing concept and describes the steps neces-
sary for licensing the Landis+Gyr MAP120 Parameter Editor.  

3.1 Introduction to the licensing concept 

After installation, the Landis+Gyr MAP120 Parameter Editor is licensed as 
Demo version, i.e. it can only be used with reduced range of functions. For 
unrestricted use of the Landis+Gyr MAP120 Parameter Editor it must be 
licensed as Professional Edition. For this, Landis+Gyr provides you with the 
following license data, to be entered in the Landis+Gyr MAP120 Parameter 
Editor: 

¶ User Name 

¶ User Group (Version) 

¶ License Key 
 
The procedure is described in section 3.2 "Entering license data".  

The license is valid for an unlimited time. The same license data can be 
used for several MAP120 installations.  

3.2 Entering license data 

This section describes the licensing procedure required for unrestricted use 
of the Landis+Gyr MAP120 Parameter Editor. The license data received 
from Landis+Gyr following your order is required for this purpose.  

Procedure: 

1. Click on Start and then under All programs in the Landis+Gyr 
program group from the menu Landis+Gyr MAP120 - 6.2 select the 
Landis+Gyr MAP120 - 6.2 command.  
The Landis+Gyr MAP120 Parameter Editor is started and the "MAP120 
- Communication Center" window appears. 

2. Click on Cancel to close the "MAP120 - Communication Center" 
window. 

3. Select License from the Extras menu.  
The "License" window appears.  

 

4. Enter the user name provided by Landis+Gyr in the "User" entry box.  

5. Select the user group provided by Landis+Gyr in the "User Group" 
selection field.  

6. Enter the licence key provided by Landis+Gyr in the "License Key" 
entry box. To prevent from illegal copying placeholders are shown 
instead of the license key after input. 
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7. Click on OK. 
The licensing procedure is terminated.  

The Landis+Gyr MAP120 Parameter Editor is now ready for use 
according to the instructions given in section 4 "First steps" or 8 
"Application of MAP120 functions", respectively.  
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4 First steps 
This section gives an introductory example of how a communication con-
nection is established to a device with the Landis+Gyr MAP120 Parameter 
Editor.  
 

Device

serial connection 
(USB or COM port)

Personal computer

with MAP120

 

A device ready for operation and an optical reading head for connection to 
a serial interface (USB or COM port) are required for this purpose. The 
Landis+Gyr MAP120 Parameter Editor must also be installed on the PC 
and licensed.  

Procedure: 

1. Connect the cable of the optical reading head fitted on the device to 
the serial interface of the PC. 

2. Click on Start and then under All programs in the Landis+Gyr 
program group from the menu Landis+Gyr MAP120 - 6.2 select the 
Landis+Gyr MAP120 - 6.2 command.  
The Landis+Gyr MAP120 Parameter Editor is started and the following 
message appears, if no communication profiles are yet defined:  

 

3. Confirm this message with OK. 
The "MAP120 - Communication Center" window appears. All commu-
nication settings must be made here as shown below. More detailed 
information can be found in section 6.1 "MAP120 communication 
center".  

4. In the selection box "Document Type" select the document type "Para-
meterisation Tree (Base Meter, Module AD-xG/xP)".  

5. In the selection box "Interface" select the serial interface to which the 
optical reading head is connected.  

6. In the selection box "Interface Type" select "Optical Head".  

7. In the selection box "Transmission Rate" select "300".  

8. In the selection box "Access Level" select "[1] Data Collection".  
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9. Click on Advanced.  
The "MAP120 - Advanced Protocol" window appears. 

 

10. Click on the tab "Access Levels" and enter a valid password for access 
level "[1] Data Collection".  

 

Setting up a commu-
nication profile 
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11. Click on OK.  
The password is saved and the "MAP120 - Advanced Communication 
Settings" window disappears.  

12. Click on New.  
The "MAP120 - New Profile" window appears. 

 

 

13. Enter a name for the new profile or leave the proposed name.  
The proposed name is made up from the main settings of the profile.  

14. Click on OK.  
The new profile is saved and appears afterwards in the selection box 
"Communication Profile Selection".  

 

Entering passwords 

Saving the commu-
nication profile 
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15. Click on Connect.  
The communication is started and the data is loaded from the con-
nected device. During this operation, which can last up to several 
minutes depending on the number of objects to read, a progress bar 
is displayed.  

 

 

After termination of the readout the loaded data is displayed as para-
meterisation tree in the Landis+Gyr MAP120 Parameter Editor.  

 

16. Select Exit from the File menu. 
After an inquiry, whether the parameterisation tree shall be saved or 
not, the application is terminated and all resources are released.  

This concludes the introductory example. Further instructions with more 
detailed explanations are provided in the following sections. 

Establishing commu-
nication connection 
and reading data 
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5 Description of user interface 
This section describes the user interface of the Landis+Gyr MAP120 
Parameter Editor.  

5.1 Overview 

The user interface of the Landis+Gyr MAP120 Parameter Editor comprises 
the following areas:  

¶ Menu bar with the "File", "View", "Communication", "Extras", "Window" 
and "Help" menus to call up functions 

¶ Tool bar with buttons for direct call-up of functions frequently used 

¶ Device definition window with tree representation (left-hand part) and 
details representation (right-hand part) 

¶ Trace window (normally not activated)  

¶ Status bar 
 

 

The sizes of the areas for the tree representation window, details repre-
sentation window and trace window can be set individually with the mov-
able separating bars situated in between (click separating bar and move 
with mouse button pressed). 
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5.2 Menu bar 

The menu bar of the Landis+Gyr MAP120 Parameter Editor contains the 
following menus for selecting functions: 

¶ File menu for file handling functions (new, open, close, save, export, 
print etc.). 

¶ View menu for display and search functions. 

¶ Communication menu for communication setting and transmit func-
tions. 

¶ Extras menu to call up functions for licensing, option setting and tree 
comparisons.  

¶ Window menu for window arrangement functions. 

¶ Help menu to call up online help and read-me files, version indication 
and update checks.  

5.3 Tool bar 

 

The tool bar of the Landis+Gyr MAP120 Parameter Editor contains the 
following buttons for direct call-up of functions frequently required: 

 
creates a new device definition and opens the "MAP120 - Communi-
cation Center" window 

 
opens a stored device definition file 

 
saves the selected device definition file 

 
prints the selected device definition 

 
calls up a print preview of the selected device definition 

 
selects the next higher folder in the tree  

 
sends the selected parameters to the device 

 
loads the selected parameters from the device (service tree only) 

 
disconnects the MAP120 connection from the device  

 
enables/disables the trace window 

 
calls up the MAP120 version indication 

 

Buttons which are not applicable in a specific situation are disabled and 
represented in grey.  
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5.4 Device definition window 

Device definition windows show a parameter representation of a device 
type (in this user manual only the parameterisation tree is described, since 
the service tree is only supported for some older firmware versions of spe-
cific devices).  

Normally the device definition window is represented maximised, i.e. it uses 
the entire space in the MAP120 Parameter Editor.  

Clicking the  button in the upper right corner of the MAP120 downsizes 
the device definition window, so that more than one device definition win-
dow can be displayed at once. Using the entries "Cascade" or "Tile" from 
the "Window" menu allows automatic arrangements of windows.  

 
 
1  Left-hand half of window with tree representation of device definition 

2  Movable separating bar 

3  Right-hand half of window with detailed view of selected tree items 

 
Device definition windows are divided into two by a movable separating bar 
(moved by clicking and shifting the bar). The left-hand half of the window 
contains a general tree representation, while on the right are displayed de-
tails of the current tree item marked (parameter or folder).  

The active window half can be changed by pressing [F6] or by clicking in 
the other window half. This does not change the focus and marking in the 
newly activated window half. In the basic condition the first tree item is se-
lected in the left-hand half and the first element for modification or the first 
button in the right-hand half. Both sectors of the window have horizontal 
and/or vertical picture scrolling functions if part of the window half cannot 
be seen. Scrolling does not affect either the focus or the current marking.  

Clicking the  button in the upper right corner of a downsized device 
definition window maximises the device definition window again.  
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A tree representation, e.g. as generally familiar from the file system tree of 
Windows Explorer, is ideally suited for clear presentation of ordered struc-
tures (e.g. of files placed in folders and sub-folders) and is therefore used 
for the representation of device definitions.  

 

 
A tree consists of a hierarchic arrangement of tree items (folders and 
parameters).  

The tree items are represented as follows:  

 Root folder 

 Folder 

 Parameter 

 Modified parameter (with asterisk) 

  Read-only parameter 

Various statuses of parameters are indicated with different colours of tree 
items.  
 
Each folder can be expanded and collapsed individually. If the tree is fully 
collapsed, only the root folder remains visible, which represents the entire 
device (all parameters).  

Collapsed folder items are preceded by an expansion sign , expanded 
folder items by a collapse sign .  

To expand or collapse folders there are the following possibilities:  

Using the mouse: 

¶ Clicking on the expansion sign  of a folder expands this folder  
(the expansion sign changes to a collapse sign ).  

¶ Clicking on the collapse sign  of a folder collapses this folder  
(the collapse sign changes to an expansion sign ).  

Tree representation 

Tree items 

Folder handling 
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Using the keyboard: 

¶ Pressing the [*] key of the numerical keyboard expands the whole tree 
below the selected folder (i.e. all subfolders and parameters will be 
visible).  

¶ Pressing the [/] key of the numerical keyboard collapses the whole 
tree below the selected folder (i.e. all subfolders and parameters will no 
longer be visible).  

¶ Pressing the [+] or [ï] key of the numerical keyboard toggles between 
the expanded and collapsed tree representation.  

5.5 Trace window 

 

i Additional knowledge required 
Additional knowledge is required to analyse communication activities.  

 

Clicking on  in the tool bar shows or hides the trace window, where all 
communication activities can be logged and analysed.  

 

The trace level can be adjusted for each category (DLMS, Wrapper, HDLC 
and IEC) individually: off, low, medium and high.  

To analyse a specific string, mark it in the trace window, click on the button 
for the corresponding analysing window, e.g. Analyse HDLC Frame and 
then click on Analyze in the analysing window.  

 



Description of user interface     21/96 

D000011154 en t ï MAP120 ï Parameter Editor ï User Manual © Landis+Gyr 

5.6 Status bar 

 

The following information is displayed in the status bar: 

¶ General status (e.g. Ready) or tooltip of a selected icon in the tool bar  

¶ Connection status (e.g. Modem) and protocol (e.g. dlms) 

¶ Type of tree (e.g. Parameterisation Tree) 

¶ Connection icon (e.g. ) 

¶ Keyboard status (e.g. NUM for activated numerical keypad) 
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6 Communication with devices 
This section describes all aspects of communication with devices, in par-
ticular work with the MAP120 communication center for various applica-
tions.  

6.1 MAP120 communication center 

All communication settings can be made in the "MAP120 Communication 
Center" window. This mainly serves to select the desired document type 
and suitable communication profile, as well as to establish or terminate a 
connection to the device.  

The "MAP120 - Communication Center" window appears 

¶ following every start of the MAP120 (except when this has been sup-
pressed in the option settings)  

¶ after creating a new document (click on  or select New from the 
File menu)  

¶ when called up (select Communication Center from the Communi-
cation menu). 

 

For a better understanding of the possible settings in the MAP120 commu-
nication center some important terms and communication parameters are 
explained below, before the completion of various communication connec-
tions is shown by means of examples in section 6.2 "Communication exam-
ples".  
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6.1.1 Document types 

The document type (tree type) must be selected in the MAP120 communi-
cation center for every communication connection to a device. The follow-
ing document types are available (depending on license):  

¶ Parameterisation Tree (Base Meter, Module AD-xG/xP) 

¶ Parameterisation Tree (Communication Unit) 

¶ Service Tree (Base Meter)* 

* Only supported for some older firmware versions of specific devices (see 
readme.txt file) and therefore not documented in this user manual. It is rec-
ommended to use the MAP110 Service Tool for service functions. 

The parameterisation tree and its application is described in detail in 
section 7 "Parameterisation tree".  

6.1.2 Communication profiles 

Communication profiles stored in the MAP120 contain all necessary 
settings for a specific type of connection to a device:  

¶ Connection specification (interface used, type of interface, transmis-
sion rate for direct connections or modem type and telephone number 
for modem connections, start protocol, COM port settings etc.).  

¶ Access specification (access levels, passwords) 

¶ Physical device address 

¶ Network delay times 

A communication profile must be determined or selected in the MAP120 
communication center for every communication connection to a device. 
With the choice of a stored communication profile all settings no longer 
have to be made separately each time. Any desired number of communi-
cation profiles can be specified and stored.  

The communication profiles are stored in files commonly for all users in the 
directory "C:\Documents and Settings\All Users\Application Data\Landis+ 
Gyr\MAP120\Profiles". Changes in a communication profile therefore affect 
all users of a personal computer. 
 
The following basic procedure should be adopted to produce and store a 
new communication profile in the MAP120 communication center (specific 
examples are given in section 6.2 "Communication examples"): 

1. Select the serial interface to be used in the "Interface" selection box or 
the modem used for remote communication and for Ethernet connec-
tions the entry of the network card to be used. The COM port number 
of a serial interface can be found in Windows under Settings / Control 
panel / System / Hardware / Device manager. 

2. For local communication select the "Optical Head" type used in the 
"Interface Type" selection box or "3-wire connection without echo" or 
for remote communication the telephone number to be selected.  

3. Select the corresponding transmission rate for the device for local com-
munication in the "Transmission Rate" selection box.  

4. Select the access level required for the intended activity in the "Access 
Level" selection box.  

5. If extended communication settings are necessary, click on Advanced.  
The "MAP120 - Advanced Communication Settings" window appears. 

Preparation example 
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6. Perform the required extended communication settings and then click 
on OK. 
The "MAP120 - Advanced Communication Settings" window disap-
pears. 

7. Click on New.  
The "MAP120 - New Profile" window appears. 

 

8. Enter a name for the new communication profile or leave the name 
suggested. 
The name suggested is formed from the most important settings of the 
communication profile. 

9. Click on OK.  
The new communication profile is stored and then appears as entry in 
the "Communication Profile Selection" box. 

 

 

i Temporary use of communication profile settings 
If it is only intended to use communication profile settings temporarily, they 
need not to be saved as communication profile. Instead, they can be used 
by clicking on Apply.  
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6.1.3 Interface to device 

The communication connection from the Landis+Gyr MAP120 Parameter 
Editor to one or more devices can be made in various ways:  

¶ Local via a serial connection to a device. 

-  With an optical reading head placed at the optical interface of the 
device (only point-to-point connection to a device possible).  

-  With a direct connection to a device, e.g. via an RS232, M-Bus or 
Ethernet interface as used in various communication units. If the 
communication unit has a second interface, multiple connections 
are possible to further devices.  

¶ With a modem connection to a device or several devices, if these are 
connected together by a multiple connection by RS485, CS or M-bus. 
Note: the modem must first have been installed and configured on the 
PC.  

¶ With a network connection over the Internet via a gateway (e.g. a 
Landis+Gyr iMEGA server) to a device or several devices, if these are 
connected together by a multiple connection by RS485, CS or M-bus. 
Note: For network connections over the Internet via a gateway a virtual 
COM port and a corresponding standard modem driver must have 
been installed.  

The connection to a PC with the MAP120 software is made either via a se-
rial interface (e.g. COM port or USB) or via a modem or network connected.  
 
The interface used must be selected in the MAP120 communication center 
in the "Interface" selection box. The selection contains all the serial inter-
faces present on the PC and all modems configured, e.g.:  

 
 
If a modem is selected, an entry box "Phone" appears for the telephone 
number:  

 
 
If a serial interface is selected, the "Interface Type" and "Transmission 
Rate" entry boxes appear. The transmission rate to be entered in the 
"Transmission Rate" box must correspond to the device settings.  

Interface 

Phone 

Interface Type and 
Transmission Rate 
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"3-wire connection without echo", "Optical Head" or "Bluetooth Optical 
Head" should be selected as interface type, depending how the device is 
connected.  

 

This is necessary because an echo signal is often produced when using an 
optical reading head, which can be suppressed by suitable means in the 
MAP120, while this effect does not occur with a direct connection.  

If one of these two effects should not take place at any time (a correspond-
ing error message is given in this case when connection is made), it can be 
corrected by clicking on Advanced and suitably changing the characteris-
tics of the physical interface or start protocol in the "MAP120 - Advanced 
Communication Settings" window appearing.  
 
Possible settings in the "Start Protocol" selection box: 

¶ IEC (default), if the IEC protocol must be used mandatory 

¶ HDLC, if the HDLC protocol must be used mandatory 

¶ COSEM Wrapper, if the COSEM Wrapper over the TCP protocol must 
be used mandatory 

 

 

Start Protocol 

Advanced 
Communication 
Settings 
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Possible settings in the "Echo Handling of Interface" selection box:  

¶ automatically, according to interface type (default), i.e. with echo, if 
an optical reading head is used or without echo, if a direct connection 
is used 

¶ with echo (e.g. optical head), if a direct connection is used, which 
causes an echo 

¶ without echo (e.g. electrical interface), if an optical reader is used, 
which causes no echo. 

Possible settings in the "COM Port Settings" selection box:  

¶ 8 Bit (8 data bits / no parity) (default), to be used normally 

¶ 9 Bit (8 data bits / even parity), to be used if the connection to the se-
rial interface of the personal computer is made via an USB M-Bus con-
verter 

Additional setting possibilities on the "Advanced Communication Settings" 
register card: 

¶ Maximum Transmission Rate (Default = 9600)  
This can be selected in the selection box for the IEC protocol. If HDLC 
is selected as start protocol, no selection is possible.  

¶ Ignore Transmission Rate Switching   
If this check box is activated with IEC protocol selected, the starting 
transmission rate selected is permanently retained. This is necessary, 
for example, for communication with devices, which must be contacted 
via a multiple connection with a lower transmission rate than required 
by the modem circuit.  

¶ HDLC transmit buffer size (Default = 128 Bytes)  
This can be entered in the entry box. The permissible range is 62 ... 248 
Bytes. Landis+Gyr recommend to reduce the HDLC transmit buffer 
size only in case of communication problems.  

¶ Maximum Number of Attributes per dlms Request (Default = 45) 
In case of readout problems this value can be reduced down to 1. 
It should be noted that this slows down the readout.  

¶ Single Request Firmware Releases  
This entry box contains all versions (separated by semicolons), for 
which automatically single requests will be used.  

¶ Network Delays (Default = 4000 ms)  
The initial delay and timeout time for problems in making connection, 
e.g. with GSM networks, can be set in the "Initial Delay" and "IEC and 
HDLC Timeout" entry boxes. Note that the "Network Delays" check 
box in the "MAP120 - Communication Center" window must also be 
activated for this setting to be effective (otherwise the IEC standard 
values remain effective).  
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6.1.4 Access levels 

An access level must be selected for every communication connection to a 
device in the MAP120 communication center.  

 

The various access levels and their fields of application are fully described 
in section 10 "Short description of device security system".  

Any passwords necessary can be changed in the "MAP120 - Advanced 
Communication Settings" window, which appears after clicking on Ad-
vanced (see section 6.1.5 "Passwords"). 
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6.1.5 Passwords 

Any passwords necessary can be changed on the tab "Access Levels" in 
the "MAP120 - Advanced Communication Settings" window, which appears 
after clicking Advanced in the "MAP120 - Communication Center" window 
(see section 6.1.4 "Access levels").  

 

 

i Changing default passwords 
Landis+Gyr recommends that the generally known default passwords in the 
device should be changed.  

 
For the user-defined access level X the client type (UID) can also be deter-
mined. This is extremely useful for temporary use of another access level 
or for access to devices from other manufacturers using different client 
types.  
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6.1.6 Addressing devices 

For point-to-point connections the device need not be specially addressed. 
But with multi-drop all devices connected to the bus system (RS485, CS or 
M-Bus) must have their own address for individual access. This address is 
called the physical device address. In fact even two physical device ad-
dresses are used, one for the IEC protocol (IEC device address) and the 
other for the DLMS protocol (HDLC device address).  

Unless otherwise specified on the order, the following parameter values are 
set as defaults for these physical device addresses: 

¶ Physical IEC device address = serial number (printed on face plate of 
device), e.g. 73852799. 

¶ Physical HDLC device address = last 4 digits of serial number plus 
1000 (because with dlms the range of addresses is limited and some 
addresses are reserved), e.g. 3799 for a serial number 73852799 
(2799 + 1000 = 3799). 

The physical device addresses are stored as parameters of the basic meter 
and not in the communication unit. A change of communication unit does 
not therefore affect the addressing.  

In the parameterisation tree the physical device addresses can found under 
"Identification Numbers".  
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6.2 Communication examples 

This section provides some examples to show how communication connec-
tions are made to devices via various communication paths and for various 
applications:  

¶ Local connection (see section 6.2.1) 

¶ Modem connection (see section 6.2.2) 

¶ Network connection (see sections 6.2.3) 

It is assumed in all examples that the physical connections (e.g. cable 
or modem connections) have already been made and the Landis+Gyr 
MAP120 Parameter Editor has already been started.  

6.2.1 Local connection 

This example shows how a multiple connection is made to several devices 
mutually connected via RS485 interfaces. dlms is used as communication 
protocol. In the layout diagram below the device numbers are given for ad-
dressing.  
 

Device
76048477

RS232

Personal computer
with MAP120

Device
75005282

Device
73706202

Device
74651799

RS485 RS485 RS485

CU
B2

CU
B1

CU
B2

CU
B2

 

Procedure: 

1. Click on  in the toolbar or select New from the File menu.  
The "MAP120 - Communication Center" window appears showing the 
settings last used. 

2. Select the desired document type in the selection box "Document 
Type" e.g. "Parameterisation Tree (Base Meter, Module AD-xG/xP)". 

3. Select or create a communication profile with the following settings 
(procedure see section 6.1.2 "Communication profiles"): 

-  Selection box "Interface": serial interface, to which the connection 
cable to the RS232 interface of the first device (in this example no. 
76048477) is connected, e.g. COM1.  

-  Selection box "Interface Type": 3-wire connection without echo.  

-  Selection box "Transmission Rate": Transmission rate according to 
the parameter setting of the device, e.g. 57600.  

-  Selection box "Start Protocol": HDLC, since access is to take place 
via the dlms protocol. 

-  Selection box "Access Level": required access level for the planned 
action, e.g. "[2] Utility Field Service". 
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4. Activate the "Physical Address" check box and enter the physical de-
vice addresses in the entry/selection box for the device to be contacted 
or select them, if they have been entered already. Enter first the IEC 
device address and then separated by a semicolon the HDLC device 
address. The IEC device address corresponds to the device serial 
number and the HDLC device address is calculated from the last 4 
digits of the serial number plus 1000, e.g. 2799 for the device with the 
serial number 74651799 (see also section 6.1.6 "Addressing devices"). 

 

5. Click on Connect.  
The communication is started and the data is loaded from the con-
nected device. After termination of the readout the loaded data is dis-
played as parameterisation tree in the Landis+Gyr MAP120 Parameter 
Editor (see section 7 "Parameterisation tree"). Then the connection is 
disconnected automatically.  

6. Perform the intended work. 

7. If it is desired to communicate with another device in the multiple con-
nection, select Communication Center from the Communication 
menu.  
The "MAP120 - Communication Center" window appears. 

8. In the entry/selection box "Physical Address" enter the physical device 
addresses of another device of the multiple connection or select them, 
if they have been entered already. In this example "73706202;7202" for 
the device 73706202. 
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9. Click on Connect.  
The communication is started again and the data is loaded from the 
connected device. After termination of the readout the loaded data is 
displayed as parameterisation tree in the Landis+Gyr MAP120 Para-
meter Editor. Then the connection is disconnected automatically.  

10. Also perform the required work for this device. 

6.2.2 Modem connection 

This example shows how a point-to-point connection is made for remote 
communication with a single device fitted with a communication unit with 
PSTN modem (CU-M2x) or with GSM modem (CU-G3x). dlms is used as 
communication protocol.  
 

RS232

Personal computer
with MAP120

Device

PSTN modem

Modem connection 33600 bps

CU
M2x

 

If further devices are connected to the device (multiple connection), their 
addressing has to be done with the physical device addresses as shown in 
the example in section 6.2.1 "Local connection". 

Procedure: 

1. Click on  in the toolbar or select New from the File menu.  
The "MAP120 - Communication Center" window appears showing the 
settings last used. 
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2. Select the desired document type in the selection box "Document 
Type" e.g. "Parameterisation Tree (Base Meter, Module AD-xG/xP)". 

3. Select or create a communication profile with the following settings 
(procedure see section 6.1.2 "Communication profiles"): 

-  Selection box "Interface": any available PSTN modem.  

-  Entry/selection box "Phone": telephone number of the remote 
modem.  

-  Selection box "Start Protocol": HDLC, since access is to take place 
via the dlms protocol. 

-  Selection box "Access Level": required access level for the planned 
action, e.g. "[6] Remote Data Collection". 

-  If the modem in the device is a GSM modem, check box "Network 
Delays" should be activated. 
This increases the time delays with respect to the standard value of 
1500 ms to the value set under "Advanced Communication Set-
tings" (default value = 4000 ms). Increasing the time delays pre-
vents the occurrence of interruptions during data transmission and 
is urgently recommended for GSM networks. 

 

4. Click on Advanced.  
The "MAP120 - Advanced Communication Settings" window appears. 

5. Click on the tab "Access Levels" and enter the valid password for 
access level "[6] Remote Data Collection".  
For test installations at Landis+Gyr "66666666" is programmed as 
password for access level 6.  
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6. Click on OK.  
The "MAP120 - Advanced Communication Settings" window disap-
pears. 

7. Click on Connect.  
The communication is started and the data is loaded from the con-
nected device. After termination of the readout the loaded data is dis-
played as parameterisation tree in the Landis+Gyr MAP120 Parameter 
Editor.  

 

8. Perform the intended work. 

9. Click on  in the toolbar or select Disconnect from Device from the 
Communication menu to conclude the modem connection.  






















































































































